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2x2 video wall controller with rotate support

e 25 editable preset display modes

e Custom modes with LCD at any angle and position
e PIP/POP

e Multi-unit cascade

e Flexible aspect ratio and display region adjustment

e Seamless looping playback with different display modes
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1 Introduction

NEXIS video wall controller VW34RA is world unique and the first pure hardware solution that can
create all kinds of display styles through IR remote controller. 25 pre-defined display modes can be selected
through OSD. User can also create any display mode for regular and irregular video wall using LCDs with
different dimension, resolution and bezel. Conventional low-cost monitor and TV can be used as display
devices. The LCD can be installed at any angle and position. User can install LCD first, then crop the required

image for each LCD by remote controller or PC tool.

VW34RA is 4 screen video wall controller with PIP/POP function and supports up to 8k/1k 30Hz and
4k/2k 60hz input signal. HDMI 2.0 loop out port is available for daisy chain connection. It can be cascaded to

create large scale video wall.

Dynamic aspect ratio and position adjustment for entire video wall are special features for VW34RA.
User has flexibility in showing different shape or cropping area contents on the video wall. It provides
programmable background color in video wall blanking area if the content is not at full screen. Seamless
looping playback is another feature to allow user to setup up to 10 display modes from the same source
content and looping playback with selectable time interval. This function can be used to highlight specific

image region or to show special effect on the video wall dynamically from the same content.

25 preset modes are integrated in VW34RA. User can select preset mode and no adjustment or setup is

required. Preset modes can be further modified to meet different panel bezel sizes and installation conditions.
System setup and control can be through IR remote controller, RS232, USB or Ethernet.

Dual power supply systems are designed in VW34RA. User can use AC 100-240V or DC12V. When

AC is applied, there will be one DC12V 1A output as the power supply for signal extender.

VW34RA is designed with highest industrial standard for 7/24 working environment. It provides a

simple, flexible and reliable solution for video wall.

440mm
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2 Features:

1)

10)

11)

Flexible video source connection

- 2xHDMI 2.0b and 1x DP 1.2a: support up to 8k/1k @30 Hz or 4k/2k @60Hz resolution.

- 1x VGA: support up to WUXGA resolution.

Quad channel outputs:

4x HDMI 1.4 outputs for connecting with 4x LCD or conventional TV / monitor.

System cascade display

One HDMI 2.0 loop out port for multiple unit cascade for large scale video wall. No HDMI splitter is

required.

Pre-defined display modes

25 pre-defined display modes that can be selected through OSD. Preset modes can be further

modified to meet user’s requirements.

Create any irregular video wall by user

- User can create any display mode for regular, portrait and irregular video wall using LCDs with
different dimension, resolution and bezel. Use can crop the required image for each LCD
through inputting the coordinates of Top Left and Top Right corners in each monitor.

- Galign PC tool and remote controller are available to upload coordinates into VW34RA.

- Windows “Paint” software can be used to capture the coordinates in each monitor.

Flexible aspect ratio control

Flexible aspect ratio control across entire video wall through OSD menu is integrated. User can
decide how to display content on the video wall if the content can’t match video wall aspect ratio.
The adjustment range is from 25% to 200% independently in horizontal and vertical directions.
Anyplace cropping

User can crop any image location to be displayed in monitor.

Flexible position adjustment

The combination of flexible aspect ratio control and position adjustment function (25% to 200%) will
allow user to determine the best image region for the display on the video wall.

Auto looping playback

User can setup up to 10 display modes from the same display content and looping playback with
selectable time interval (1 second to 600 seconds). This function can be used to highlight specific

image region to show special effect on the video wall dynamically from the same content.

Any display devices
Conventional TV/monitor can be used at top/bottom, LH/RH flip position to balance TV bezel
difference between top and bottom edges.

Programmable EDID
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12)

13)

14)

15)

16)

17)

18)

19)

20)

Preset 23 EDID + programmable EDID setting to optimize input resolution. Programmable EDID has
below resolution range: H: 1024-3840, V: 720-2400

LCD burn-in mark protection

Auto image position shift to prevent LCD from burn-in mark.

Adjustable OSD position

OSD menu position can be shifted for convenient OSD operation.

PIP function

Picture in Picture from two selected signal sources with flexible position and image size (up to
1920*1200), PIP image can be further adjusted by Overlap function to get various size and shape.
PIP image can cover full screen across entire video wall.

POP function

Image Side by Side display with full screen or maintain original aspect ratio. Two POP contents can
be displayed on LCDs at RH/LH or up/down positions with monitor at landscape direction.

System setup

User can setup the system through IR remote controller, USB or Ethernet. User can connect
VW34RA to WiFi router and execute system setup via WiFi through any device connected with the
same WiFi router. WebGui and Galign PC tool is available for Ethernet operation.

System control

User can control VW34RA through IR remote controller, USB, RS232 and Ethernet.

Auto power on/off control

When no input signal is detected, NEXIS Wall Box can auto-turn off output signal. Once input signal
is detected, it will auto-turn on NEXIS Wall Box and send out signal again. It is convenient for
system power on/off control.

Selectable background color

When adjusting aspect ratio, user may see some blank background in the video wall. User can
select background color by OSD.

Custom settings

Up to 10 different display modes settings in the same signal source can be stored. 5 display Profiles
with different input source and PIP/POP setting can be stored. User can recall at any time through

remote controller, RS232, USB or Ethernet.
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3 Helpful tips for installation and operation

1)

2)

3)

4)

5)

6)

7)

8)

9)

10)

User can set Box ID for independent control among multiple NEXIS Wall Box by remote controller.

851: control NEXIS Wall Box ID No. 1, 853: control NEXIS Wall Box ID No. 3,

850: simultaneous control for all NEXIS Wall Box

User will see flashing LED on front panel after press 85x number keys. It means the NEXIS Wall

Box with flash LED is locked and will not be controlled by remote controller.
To use Galign2 PC tool through USB or Ethernet for the setting is recommended and use remote
controller for image position fine-tune.
NEXIS Wall Box test pattern is important for video wall image position adjustment. It can be
downloaded from website at |:|
25 preset display modes selected through OSD menu. User can select preset display modes and
modify as need. It will save the time for the setup.
If user wants to create his own video wall which is totally different from preset mode, the quickest
way is to install the LCD first, take a photo of the video wall, crop and get coordinate through
Windows Paint in top left and top right corners in each LCD, then input the coordinates into
VW34RA through Galign2 PC tool to get the result.
User can use below hotkeys in remote controller for image fine-tune:

[Shift]: to shift image position in H&V without changing image size and direction.

[Top RH] / [Top LH]: to change image size, position and display angle

[Ratio]: to enlarge or shrink the image for full screen display or aspect ratio change

[Position]: after [Ratio] adjustment, user can shift entire video wall image position.

[Pattern]: adjust OSD position for convenient OSD operation.
OSD Lock / Unlock: When continuously press [MENU] key in IR Remote Controller for 5 seconds,
the OSD function will be locked (LED on front panel will be flashing). To press MENU key for 5
seconds again, it will unlock OSD.
Poor signal cable connection or long cable may cause noise or discontinue on the display.
Replace a new cable may solve the problem. Normal HDMI connection with good cable can be up
to 15m. 4k/60 input signal will be more sensitive to cable quality.
User may not see complete image for signal source setup. User can use remote controller to select
one display Mode # which is not stored any setting to display full image. After finish signal source
setup, then return to the working Mode for further operation.
When operating via OSD, user may not see OSD menu. Please click [Pattern] hotkey together with

direction keys to shift the OSD to visible position for easy OSD operation.


https://www.mc.co.th/eshop/full-hd-1-in-4-out/3824-2x2-video-wall-box-90180270-rotate-support-with-pip.html
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4 Qutlook and main functions

= =

=l @ ==

Output Ports
TV3/TV4

Input Status Output Status

Input Ports Output Ports Control ports

Loop out

TV1/TV2 USB, IR, IP

5 Functions in Remote controller

POWER

PROFILE INFO CHAB

O E @

Channel Selection

SHIETY m VAl
0O O
TOPLH TOPRH EI() PATTERN

@ ac

ALL SAVE  RESET  OVERLAP

__—~ System Information
_ Output port selection (TV1-TV4)

Store location for Display modes

1)

2)
3)
4)
5)
6)
7
8)
9)

Procedures for determine each LCD image position

Select display Mode #—Mode 1~Mode 4 (please select Mode 5 to Mode
10 through OSD)

Select output port—TV1~TV4

Click Top Left [TL] and input coordinates

Click Top Right [TR] and input coordinates

Click [Shift] and adjust image position if necessary

If user can’'t see OSD menu, click [Pattern] to shift OSD position.

Adjust aspect ratio if necessary: [Ratio]

Adjust image position if necessary: [Position] (after aspect ratio change)
No special input sequence is required among TV1~TV4.

" Video wall Main Menu [VW]

—— Entire video wall position adjustment [P]

 Shift OSD position to visible location.
‘; " Entire video wall Aspect Ratio adjustment [R]
h To adjust image position at H&V without changing image size [Shift]
Top Right coordinate menu [TR]
Top Left coordinate menu [TL]
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6 Basic concept for video wall configuration

116.8¢cm

11) [Top RH] & [Top LH] X/Y coordinates determine the image position

12)

13)

Image allocation for each LCD is based on [Top RH] & [Top LH] corner X&Y coordinate value
in 1920*1080 coordinate system. The coordinate system must keep 16:9 aspect ratio.
Original point (0,0) is located at Top Left corner. (1920, 1080) is located at Bottom Right
corner.

No matter the LCD is located at any location, once it is 16:9 aspect ratio, user can assign the
image location to each LCD through [Top RH] & [Top LH] X&Y coordinates.

Through [Top RH] & [Top LH] coordinates change, user can adjust the image size, rotation
angle and position in each output.

User can setup video wall through design drawing and calculate the distance to convert into
X&Y coordinates or take photo of the video wall, then convert it into X&Y coordinates through
Window [Paint] software.

After collect [Top RH] & [Top LH] X&Y coordinates, user can upload X&Y values by remote
controller or Galign2 PC Tool. Galign2 PC tool is recommended for easier and quicker setup.

[Shift] function is to adjust X or Y values at [Top RH] & [Top LH] at the same time resulting image

shifting in H&V direction without change image size. It applies to each output for position fine-tune.

[Ratio] & [Position] functions allow user to change complete video wall image aspect ratio and

image position.

1920*1080 Coordinate system

- 382.5cm >
(0, 0) (Original Point) (1920, 0)
| i . i i 1A
-t 89— »
- 3G ne
" 1920/382.5%89=447
—Y .. . 1080/215.2%53=266
(366,216) '\ (447, 266) 5
2
2
o &
b=
(0, 586) | g3
A | It
- ~ 162.3cm (3, )
7 1920/382.5*162.3=815
1080/215.2*126.6=635
L | 4
(0, 1080) (1920, 1080)

10
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7 Preset Display Modes

7.1 Introduction

>
>

>

LCD panel used in Preset Mode must have the same size and 16:9 aspect ratio.

Preset mode doesn’t take LCD panel bezel size into consideration. It is good for slim bezel under
3.5mm active to active bezel size. If the bezel is larger, user may need to do further bezel
correction through position fine-tune in each LCD.

If the preset mode with LCD at 0/90/180/270 degrees, it will be less sensitive to bezel size. User
will still see acceptable video quality even the bezel is up to 5-10mm width.

The preset modes will fit complete source image with full screen across entire video wall. It will
not consider the aspect ratio of the signal source.

User can also use [Overlap] function under [Video Wall] menu to adjust the cropping area of the
signal source for entire video wall.

User can use [Ratio] & [Position] OSD menu to adjust final aspect ratio and position in the video
wall based on the image that is cropped through [Overlap] function.

Customized Mode can be created with all kind of LCD without size and bezel limitations.

7.2 LCD (TV) selection for Preset Mode

YV V VYV V

Type of LCD: low cost 16:9 LCD or TV can be used. No need to have matrix control feature.

All the LCD panels used in the same video wall must have the same size and 16:9 aspect ratio.
Some Display Modes support TV at top down flip position to balance the bezel difference.

Output resolution: the default output resolution is 1920x1080 @60Hz in each output channel. The

LCD must be able to support FHD input timing.

7.3 Select Preset Display Modes through OSD

£
(3

Mode Index Overlap Position

8 69 T T
& ¢ < M

CHANNEL 1

11
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User can use remote controller to select preset display modes.
[Video Wall]=> [Mode Type]-> select display mode

1st mode is to output 4 signals same as signal source. It is similar to 1x4 HDMI splitter.

vV V VY V

User can switch the display angle in each display mode by 90/180/270 degrees. It will create

different display mode.

KN
- B

12
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7.4 Preset display mode list

» User can select Preset Mode as base
to create customized display modes.

» Image aspect ratio can be adjusted
through [Ratio] & Video Wall [Overlap]
function.

» Below Preset Modes don’t consider
Bezel size. User can use [Shift], [Ratio]
and/or [Top LH] / [Top RH] coordinate
adjustment function in remote controller
or PC tool to get accurate bezel

correction and image location.

Mode O - Duplicate Mode

When system is reset, it will show 4 duplicated

windows same as signal source in all outputs.

Mode 1 — 2x2 (Ratio 16:9)

13

Mode 2 — 2x2 with top two TV upside down

(Ratio 16:9)

Mode 3— 4x1 (Ratio 2.25)

Mode 3A — 1x4

Apply 90° signal source or
rotate image at 90° to get
normal viewing angle from
Mode #3.




VW34RA User Guide

Mode 4 — 3x1 (Ratio 1.69)

(#4 output will show full screen image)

Mode 4A — 1x3

Apply 90° signal source or
rotate image at 90° to get
normal viewing angle from
Mode #4.

Mode 5— 2x2 with TV2 & TV4 shift down 1/2 panel

Mode 6— 2x2 with TV2 & TV4 shift down 1/2 panel

height (Ratio 1.42)

Mode 7 — 2x2 with clockwise 15° rotation (Ratio

1.7)

Mode 8 —2x2 with clockwise 15° rotation and

height (Ratio 1.42)

14

TV1 & TV2 at upside down position (Ratio 1.7)
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Mode 9— 2x2 with TV3 & TV4 Right shift 1/2 panel Mode 12A

width (Ratio 2.22)

Apply 90° signal source or
rotate image at 90° to get
normal viewing angle from
Mode #12.

Mode 10— 2x2 with TV3 & TV4 Right shift 1/2
panel width (Ratio 2.22)

Mode 13 =TV2 & TV4 Down shift with 1/4 panel
height (Ratio 1.8)

Mode 14 — TV4 Down shift 1/4 panel height (Ratio
18)

Mode 12 — (Ratio 5.33) for 3x3 application

Mode 11 —(Ratio 1.89)

15
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Mode 15 — 75° counterclockwise rotation (Ratio Mode 18 — 45° clockwise rotation (Ratio 1.0)

1.77) (#4 output will show full screen image)

Mode 16 — (Ratio 1.16)

Mode 19 —45° counterclockwise rotation

(Ratio 1.1)
v" Panel top and bottom at the same height.

Mode 17 —45° counterclockwise (Ratio 1.0)

v Panel location at half position

16
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Mode 20 — 45° clockwise rotation (Ratio 1.33)

Mode 23 (Ratio 1.0)

Mode 21 — (Ratio 1.0)

Mode 24 — 45 degrees rotation (Ratio 1.0)

% 4

Mode 22 (Ratio 1.0)

4

17
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8 Galign2 PC tool

8.1

8.2

8.3

8.4

8.5

Introduction

>

Galign2 is specific PC tool for VW34RA. User can input coordinates for [Top RH] & [Top LH]
corners of the image in each LCD to get video wall. System setting, control and code update
can also be executed through Galign2.

If user selects Preset display mode from OSD, user can read back the setting parameters and

execute further editing to match what he needs.

Preparation for Galign2 operation

>

PC with Galign2 PC tool: please download from website at

[Support]--> [PC Tool]=> [VW34RA Creative Video Wall]

USB Type B cable or Ethernet cable together with switcher/Hub/Router.
Apply source signal to VW34RA with NEXIS Wall Box Video Wall test pattern. Please download

pattern from:[Support]--> [Test Pattern]> [VW34RA Test Pattern]

The test pattern has number scale on it and user can estimate from the test pattern the adjusting

pixels to move the image to correct position.

Connection

>
>

For system setup, we propose to use USB through USB Type B connection.

If the box is far away from installation site, Ethernet connection is recommended. VW34RA

default IP address is 192.168.0.100. User can change it through OSD, Web Gui or Galign2 PC

tool.

v Direct connection through UTP cable: user needs to set PC/NB with the same IP segment,
such as 192.168.0.10x.

v" WiFi router: user can connect VW34RA to WiFi router through LAN port and select DHCP or
static IP for the connection in OSD. Once PC/NB connects with this WiFi router, user can find
VW34RA and execute Galign2 operation.

v" When multiple units of VW34RA are used, user can set different IP address in each VW34RA

and control multiple units at the same time through different IP address.

Prepare coordinate value off-line

» User can operate Galign2 without connecting with NEXIS Wall Box. If the coordinates value for

each LCD are available, user can input the value into Galign2 and save it in PC. After connecting
with VW34RA, user can load it from PC and upload the coordinate values into VW34RA by

[Write] command and see the final result immediately.

Galign2 PC Tool operation

18
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» TV1-TV4 represents VW34RA output ports from CH-1 to CH-4.

» For Preset Mode, user needs to follow the sequence, location and direction in Preset Mode menu
to install the video wall.

» If no PC for Galign2 PC tool operation, user can still use remote controller or WebGui to execute

coordinate key-in, position fine-tune, aspect ratio and position adjustment...etc.

% VNS GeoBox Align Tool W1.028.190702 - pos
" - " 192 . 168 . 0 . 100 * USB 1 Connect
19
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Below item # corresponds with the RED # in Galign2 operation window.

(1) [Connect]:
- After select type of connection, click [Connect] to connect Galign with VW34RA. Default connection
type is [USB].
- After open [Galign], all the parameters will be reset to default value. User can load previous setting by
[Load Setting] (15) from PC or [Read] (3) function from video wall or Preset Mode.
(2) After connection, user will see model # and output resolution. Default output resolution is 1080p.
(3) [Read]:
- Functions: a. Read back parameters from video wall setting. b. Read back parameters from Preset
Mode which is selected by remote controller. C. Read back parameters from display Mode (11).
- After user selects Preset Mode from OSD through remote controller, when user clicks [Read], Galign
will read back the parameters of Preset Mode and save to Index #1 (default Index # is 1). If user

selects other Index # and implement [Read] command, it may not read back Preset Mode parameters.
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(4)

S

(6)

(7)

After Read back parameters, user can select another Index # and use [Write] (5) command to save to
other Index #. User can do further editing for Preset Mode and create customized display mode.
If user saves the setting into display Index (11), user can select the display Index and click [Read] to

read back the setting. The video wall will stay the same until [Write] command is executed.

Location for Key-in or editing the coordinates of Top Left corner and Top Right corner for TV1-TV4. The
coordinates can be captured from Preset Mode, video wall picture or project plan files. If user checks
[Diagram] (7), user will see the adjusting result in the Diagram but not in the Video wall before executes
[Write] (5) command. User can also CHECK [Real Time] (6) to see the result real time in the video wall.
[Write]

After finish all settings in Galign, the image is still controlled by PC. User needs to use [Write]
command to upload all parameters into VW34RA.

User needs to disable [Real Time] function before execute [Write] command.

User can save up to 10 different display Indexes. Please select [Index #], then click [Write] to save
Galign parameters. The settings can be saved into any display Index # and can be duplicated.

It only saves the image settings showed in Galign but not includes input ports, color, PIP setting,
EDID...which will be saved in Profile Index.

If user wants to show specific Mode settings, please select Index #, click [Read] to read the
parameters, then click [Write] button to upload the settings to video wall and see the final result. User

can use remote controller Mode hotkey (#1~#4) to show the setting directly.

[Real Time]:

When user executes editing preset mode or creates new custom display mode, please check [Read
Time] so that user can see the image change while changing parameters.

[Real Time] mode shall be disable when user wants to key-in coordinate data or [Write] the result to
NEXIS Wall Box.

[Diagram]:

If user check [Diagram], there will be a diagram showed up near Galign window.

This diagram will update real time while user changes the coordinate values in coordinates. The
[Warp Ratio] and [Warp Position] changes will not be showed in the diagram.

Below left diagram presets mode selected by OSD and the right diagram is showed in Galign. Please

note that the color in each LCD is corresponding the output channel (TV1-TV4) in Galign window.
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(8) [Shift Mode]:
- After check [Shift Mode], user can change [Top Left] X&Y value to shift image position in H&V
directions for each TV without changing the image size and angle. Each channel is independent.
- While executing [shift] function, X&Y values must be also in the range 0-1920 for X direction and
0-1080 for Y direction.
(9) [wWarp Ratio]:

- [Warp Ratio] will apply to all channels at the same time to enlarge or shrink complete video wall image
in H&V direction from a range 25% to 200%.

- All Preset Mode will show entire source content. If the video wall in not 16:9 aspect ratio, [Warp Ratio]
has been applied to Preset Mode to show entire image in the video wall.

- User can change [Warp Ratio] to change cropping area or change aspect ratio.

- The result will not be showed in [Diagram].

(10) [Warp Position]:

- When the video wall has applied [Warp Ratio], user can shift complete video wall image position by
[Warp Position].

- The adjusting range for [Warp Position] is followed the percentage in [Warp Ratio]. If user didn’t adjust
[Warp Ratio] (value is 100), then no [Warp Position] adjustment is allowed.

(1) [Index #]:

- Index # is the location to save parameters created in Galign. It doesn’t include other settings that is not
inside Galign, such as input selection, PIP or EDID setting.

- User saves up to 10 Indexes and executes seamless looping playback to show special effect for the
video wall.

- [Write] command is to save Galign settings into display Mode.

- When user click Index #, then click [Write], it will erase original setting and replace with new
parameters in each TV. If user click [Read], then click [Write], it will upload the settings in that Index #
to the video wall and user will see the final result.

(12) Profile [Save]:
- After select Profile index # (1-5), user can save the final settings to VW34RA together with other
settings from Remote controller, such as input source, PIP/POP, video wall settings, color, EDID...
- Please select one Index #, then click [Save] to save the setting. The result is the same as Profile
Save executing from remote controller.
- All channels will be saved at the same time. Maximum 5 Profile Indexes can be saved and recalled.
(13) Profile [Load]:
- User can load back Profile settings and execute further editing.
(14) [Save Setting] in PC:
- User can save Galign settings in PC as a backup or copy to other VW34RA through [Save Setting].
(15) [Load Setting] from PC:

- User can load Galign settings from [Save Setting] command and execute further editing.
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(16) [Loop Range]:

- [Loop Range] is to select display Index # for looping playback.

- It will start from Index #1. If user selects [5], it means the system will execute looping playback for
Index #1 to #5.

- The display Modes for looping playback shall be continuous. User needs to arrange the sequence of
the display Modes in advance.

(17) : [Loop Time]:

- [Loop Time] is to set the time interval from one display Mode to next display Mode in looping
playback. If user wants to display specific display Mode with double time, user can save the same
setting in the next display Mode and put it into Loop Range.

(18) [Reset]:

- [Reset] is to reset selected display Mode to default value and let NEXIS Wall Box to show source
image on each LCD. [Reset] only resets selected Index and the data in other Indexes will not be
reset.

- User can select one display Mode without saving data and click [Reset] button to reset complete

video wall to default status.
- User can also use [Reset] hotkey on the bottom of remote controller for system reset. This reset

function will erase the data in all Indexes. Here is the process:

--Reset All: [Reset]—> click [Right direction key]=> Enter.

--Reset [Video wall setting]: Reset-> click [Left direction key]> Enter.

(19) IP address setting:
- User can execute IP address setting from remote controller OSD menu, Web Gui or Galign.
- If multiple units are used at the same time and setup by Ethernet, user can set different IP address
for each unit so that user can use one PC to control all units at the same time.
(20) [Firmware update]:
- User can update both Firmware and MCU Code through this function.
- No update sequence between Firmware and MCU code.
- The system will recognize the type of the software and install to the system automatically.
(21) Browser the file for code update
- If the file is compressed, please decompress to .bin file for execution.
(22) [Start]: After press [Star] key, the system will start to update the code. It may stop for some time in some

stage. It is normal. Please wait till see [OK] message, the re-boot the system to check the result.

PS. After finish code update, please insert small pin into RESET hole of back panel for 5 seconds to reset the
system again. It will remove all previous settings into default value, including all settings in display Modes and

Profile Indexes. If user doesn’t like to remove old settings, this process can be neglected and if user finds
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abnormal conditions, user can reset through OSD menu and it will keep the settings saved in Profile Indexes

but will clean display Mode settings (mode #1-Mode #10)

e
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9 Preset Mode editing via Galign2 PC tool

If user wants to create customized display mode, user has two ways:

» To select Preset Mode as base and customize it.

» To create completely new display mode through Manual operation.

9.1 Select Preset Mode via remote controller or WebGui

» Remote Controller is attached in the shipping package.

» WebGui is available when user connects VW34RA with Ethernet through IP address: 192.168.0.100.

» Activate [Video wall]=> [Mode Type]> Select Preset Mode by icon.

9.2 How to read back Preset Mode setting value

» Open [Galign2] PC tool.

» Click [Connect]. After connection, user will see model number and output resolution at Bottom Right
location.

» Click [Read]. User will see current display parameters in Galign2 window.

> If user Loads the file from PC, all the parameters will be showed in Galign2. User can select Mode #

and click [Write] to store the parameter settings.
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9.3

9.4

9.6

Reset Preset Mode setting

Galign2: [Reset] key will reset the settings in all channels to default. All outputs will have the same
signal as signal source. It can be served as 1x4 HDMI splitter.

Remote Controller: User can use remote controller to reset all channel settings. Press [Reset] hot
key in the bottom of the keypads, click RH or LH of the direction key once, then press OK. RH
direction key will reset [ALL Setting]. LH direction key will reset only [Video Wall] settings.

Real time editing for Preset Mode

Click [Diagram], a diagram near Galign2 window will show the image allocation in 4x LCDs.

Click [Real Time]. User will be able to see the real time image change in the LCD while changing
parameters settings.

Open NEXIS Wall Box test pattern with Windows Paint and set full screen display. User can follow this

pattern to stitch the image into one big image.

Remote controller is also available for image adjustment.

Image position adjustment in each LCD

[Shift Mode]: Image H&V position shift in each channel without changing image size and angle.
[Top LH] & [Top RH] coordinates adjustment: Image rotation and size adjustment.

X coordinate value range is 0-1920 and Y is 0-1080. While image adjustment, the value shall be
under the range.

If the image position still can’t reach required location due to above range limitation, user can shift
the coordinate value to change the image. The image will be enlarged or shrunk and some image
may be outside the border and can’t been seen. After finish all LCD images adjustment, user can

use [Warp Ratio] function to shrink the complete video wall image and see full screen.

Aspect Ratio adjustment

User has two methods to change complete video wall aspect ratio

>

>

9.7

>

To change the cropping area of signal source from [Video Wall] OSD menu. User can use [Zoom],
[Pan] and [Overlap] to crop the location you want to display on the video wall.

To use [Ratio] and [Position] in Galign 2 PC tool or remote controller to enlarge or shrink the image
and select the display region. This function can only handle the image after cropped by the above

[Video Wall] function.

OSD position shift

While image editing by remote controller and OSD, user may not see full OSD menu. User can click

[Pattern] key together with direction keys to shift OSD position to a location that user can easily see.
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10 Preset Mode editing via remote controller

10.1 Select Preset Mode via remote controller

» Activate OSD-> [Video Wall]-> [Mode Type]-> select icon
» If user doesn'’t select Display Mode #, it will save the select Preset Mode in Mode #1.

> User can select different Mode # then to select different Preset Modes.

10 Mode # for store different display settings 25 preset display modes can be selected

N 21 1 ]

Mode Index Overlap Position

Mode Type Zoom Pan Overlap Position

6
BB

eMode 1 Mode 2 Mode 3 Mode 4 Mode 5

Mode 6 Mode 7 Mode 8 Mode 9 Mode 10 Loop

10.2 Procedures for Preset Mode editing

1) Select display Mode location if multiple display Modes have been saved. Remote controller can only
select Mode #1~ Mode #4. If user wants to select display Mode # larger than 4, user needs to select
display Mode # from OSD.

2) Select output port—CH-1-CH-4 (LCD1-LCD4).

3) Click [Shift] to do image H&V position adjustment in each.

4) Click Top LH and Top RH to shift image size and display angles.

5) If user can’t see OSD for the operation, please click [Pattern] key together with direction keys to shift
OSD position.

6) Click [R] to adjust entire video wall aspect ratio if necessary.

7) Click [P] to adjust entire video wall display position if necessary.

8) User can select Top LH/Top RH keys first, then select Mode or TV1-TV4 to key-in coordinates. No
special sequence is required.

9) [Reset] function from remote controller will delete all settings in all output channels. Profile Indexes

setting will not be deleted.
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POWER
PROFILE _INFO CHAB

G Cd G

Channel Selection

TOPLH TOPRH RATIO | PATTERN

ALL SAVE RESET OVERLAP

Profile Load hotkey

Output channel selection (TV1~TV4) (2)
Display Mode (#1~#4) (1)

OSD operation buttons

[Position]: adjust entire image position after [Ratio] Adjustment (7)
Global Video Wall menu (for multiple unit cascade application
[Shift]: Image position adjustment for each output (3)

~ [Pattern]: OSD position shift

Entire video wall aspect ratio adjustment (6)
Top Right coordinate menu (4)

" Reset Hotkey
_ Top Left coordinate menu (4)
" Profile Save hotkey
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11 Preset mode application case study

11.1 Preset Mode: Mode 01

1) Connect VW34RA outputs to related LCD
- CH-1toTV1
- CH-2toTV2
- CH-3t0TV3
- CH-4toTV4

2) If bezel compensation is required, please apply
NEXIS Wall Box test pattern and change
coordinates in each channel.

- TV1: Reduce X coordinate in Top RH to
enlarge image to bezel center point in both
H&V directions.

- TV2:Increase X coordinates in Top LH to
enlarge image to bezel center point in both
H&V directions.

- TV3: Reduce X coordinate in Top RH to
enlarge the image and use [Shift] to shift the

image up.

- TV4:Increase X coordinate in Top LH in TV4
to enlarge the image and use
[Shift] to shift the image up.

| 3) After the bezel compensation, if user can’t see full

Windows 8
Ultimate

e e e e

27

screen image, please use [Ratio] & [Position] to
do fine-tune.

4) User can show dual contents in one 2x2 video
wall through PIP or POP function. No need to
change any connection. Two sources for PIP/
POP shall be HDMI + DP, HDMI+VGA or DP
+VGA.
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11.2 Preset mode 19 with two VW34RA cascade

» VW34RA can support multiple unit cascaded with Preset Mode. Maximum unit is 15x15=225.
» Connect signal to 1st VW34RA HDMI-1, then daisy chain to next VW34RA through Loop Out port.

Maximum input resolution is 4K/2K @60Hz or 8k/1k @30Hz.

Overlap region

G413-A \ G413-B

2.

4 E ELECIRIRIED CAR CING?
ee— 3 o
- < -
. = — _ IssAN
B 3

11.2.1 Setup method

» To set different IP for each VW34RA through OSD or PC tool if user wants to use Ethernet for

the setup in multiple units at the same time.
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» User can use IR remote control, USB or Ethernet for system setup.
11.2.2 Setup procedures

» Follow the instruction in Preset Mode 18 to do signal connection in both VW34RA. One VW34RA

control left four LCD and another one controls right four LCD.

» Global Video Wall settings in VW34RA-A
Activate OSD-> [Video Wall]=> [Zoom] H=2, V=1 = [Pan] H=1, V=1
» Global Video Wall settings in VW34RA-B
Activate OSD—> [Video Wall]=> [Zoom] H=2, V=1 = [Pan] H=2, V=1
» Video Wall [Position] settings:
When use Zoom function to split the image, it will cut the image from middle. Actually VW34RA-A &

VW34RA-B images has some overlap. Therefore, user needs to crop more pixels for

VW34RA-A in LH side and VW34RA-B in RH side.

Based on the panel arrangement, the overlap is about 11.5% in horizontal direction. If the input
is 3840*2160, estimated cropping pixels for each unit are 3840*11.5%/2=221

pixels.

Activate OSD~> [Video Wall]> [Overlap]> Select VW34RA-A Right Edge—> set value at +221,
select VW34RA-B Left Edge—> set overlap value at +221. The value in two VW34RA should be

the same to get the same scaling factor.

» Fine-tune image position may be required through the same procedures as that in single unit

application by Galign2 PC Tool or remote controller.
11.2.3 Multiple contents display in cascaded video wall

» User can select different input sources for Display Unit A & B and set video wall [Zoom] H=1, V=1
in both VW34RA to display different contents in the video wall. It can be saved into another Profile
[Index]. User can switch between different display modes to show different display style in the

video wall.
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» User can use PIP/POP function to add more display content in each VW34RA. In this case,

the maximum display contents will be up to 4 in the above video wall.
11.2.4 Six monitor video wall

» User can use two units of VW34RA to achieve 5/6/7/8 TV video wall based on the system
connection with the same Preset Mode.

» For 6 LCD display, user can also use Preset Mode 18 to create it.

» Below is the signal connection. Only two channels of VW34RA-B are connected.

» Video wall setting is the same as 8x LCD but the value for Overlap setting will be bigger. User can

increase same overlap value in [Right Edge] in VW34RA-A and [Left Edge] in VW34RA-B to get it.

11.3 More Examples for Preset Mode cascade

2x Mode 21, recommended signal source resolution: 3840*1080. Use [video wall] menu to cut

the image into two portions for two VW34RA.

30



VW34RA User Guide

12 Create custom display mode through OSD menu

The purpose for [Mode Index] is to save Preset mode parameters and let user create any type of display
mode as he wants. Here is the structure and concept:

» Up to 10 different display modes that can be saved in [Mode 1 to Mode 10].

» Select Mode #, then select Preset Mode from [Mode Type] menu. It will save Preset Mode into
selected Mode #. User can also input Top Left and Top Right corner coordinates through OSD or
remote controller and store the result in selected Mode #.

Each Mode consists up to 4 LCD—[TV1]~[TV4]. Each TV # image position can be further edited.
Seamless looping playback with selected display modes can be implemented by [Loop] settings.

User can adjust Horizontal and Vertical aspect ratio through [Ratio] menu.

YV V V V

User can shift entire video wall image position through [Position] menu.

12.1 Select the location to store custom display mode—[Mode Index]

1) Under [Mode Index], there are 10 [Mode

()

#] menu and [Loop] menu.

2) Each [Mode #] stores one display mode.

@ @ EE @ 3) User can apply different input source and
Mode Type Zoom Pan Overlap Position

resolution without affecting display mode

eMode! Mode2 Mode3 Mode4 Mode5 settings.

Mode6 Mode7 Mode8 Mode9 Mode10 Loop 4) Loop menu is for looping playback setting.

CHANNEL 1

12.2 Input coordinates for [Top LH] & [Top RH] corners in each LCD
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AN
N7

Mode Type

Mode Type
e Top Left

0

0

Top Right

=

Zoom Overlap Position

Reset

CHANNEL 1

3

(24

Position

Overlap

= B

Zoom
Shift Reset
1820

0

CHANNEL 1

12.3 Shift OSD position:

1) Each [Mode #] has 4 LCD (TV1 ~TVA4) for
user to assign image location.

2) [Ratio] is to do further adjustment in
aspect ratio, position shift & background
color in entire display (4x LCD at the
same time).

3) [Reset] is to reset all the settings in [TV1]
~ [TV4].

1) Inside each [TV], user needs to input
coordinates of [Top Left] and [Top Right]
corners to decide the image location.

2) [Reset] will reset the coordinates to
default settings in current [TV] setting.

3) User can manually input the coordinates
for [Top Left] and [Top Right] corners by
remote controller or Galign2 PC tool.

When input coordinates value, user may not see OSD menu and value. User can finish TV1 setting

first, then shift OSD menu to TV1 by click [Pattern] + direction keys. Then user can see all the

coordinates value for all other TV settings.

12.4 Position fine-tune by [Shift] function in each LCD

Mode Type
e Top Left

(o)

0

= B

Zoom

Top Right

Overlap

(24

Position

Shift Reset

1920

(o]

CHANNEL 1

1) [Shift] hotkey is in remote controller to allow
user shifts image position in H&V directions
for each LCD without change the size and
display angle.

2) Galign2 has [Shift Mode] in each TV to
implement this function.

12.5 Change aspect ratio, position & background color—[Ratio]
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@@Tﬂ@

Mode Type Zoom Overlap Position

TV4 e®Ratio

CHANNEL 1

Four items under [Ratio] menu:
[Ratio], [Position], [Background] & [Reset]

Note: User can also adjust image aspect ratio for entire video wall by [Overlap] under [Video Wall]

menu. User can easily Zoom In (enlarge) the image by reducing image capture range and also

increase Overlap value to shrink the image. [Overlap] function is to change crop range in source

image and can also change entire video wall aspect ratio in Preset Mode.

E‘@Wﬂ@

Mode Type Zoom Overlap Position

CJ &3] (63

Position Background

CHANNEL 1

12.5.1 Horizontal [Ratio] adjustment

EIE{@@@

Mode Type Zoom

Overlap Position

(<]

174

=]

CHANNEL 1
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1) [Ratio] and [Position] function will apply to
entire video wall (4 LCD) at the same time.

2) The display aspect ratio adjust range is from
25% to 200%. The result is similar to image
[Zoom In] & [Zoom Out].

1) This function can execute Image Zoom In
& Zoom Out to change the aspect ratio in
Horizontal direction by R/L arrow keys.

2) The aspect ratio adjusting range is from
25% to 200%.

3) This function will apply to entire video

wall.
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iy

Ratio)

(50% Horizontal

(200% Horizontal Ratio)

1) This function can execute Image Zoom In
& Zoom Out to change the aspect ratio in

vertical direction by Up/Down arrow keys.
= B8 L &

Mode Type Zoom Pan Overlap Position

(<]
174 ; . 3) This function will apply to entire video

=]

2) The aspect ratio adjusting range is from
25% to 200%.

wall.

CHANNEL 1

gy g

(50% Vertical Ratio) (200% Vertical Ratio)

12.5.3 Horizontal [Position] adjustment
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3
B E @D

Mode Type Zoom Overlap Position

» [ c

Position Background

CHANNEL 1

1) Image horizontal position shift can be
executed by R/L arrow keys.

2) No image shift is possible if Horizontal
[Ratio] doesn’t change.

3) Horizontal adjusting range is from 25% to
200%, depending on [Ratio] adjustment.

4) This function will apply to entire video

(50% Horizontal Ratio) (50% shift to left) (50% shift to right)

12.5.4 Vertical [Position] adjustment

%@@Eﬁ-

Mode Type Zoom Overlap Position

35

1) Image vertical position shift can be
executed by Up/Down arrow keys.

2) Vertical range will depend on the change
in Vertical [Ratio], max. range is from
25% to 200%.

3) No image shift is possible if Vertical
[Ratio] doesn’t change.

4)  This function will apply to entire video
wall.
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(200% Vertical Ratio) (Max. shift to Top) (Max. shift to Bottom)

(50% Vertical Ratio) (50%. shift to Top) (50% shift to Bottom)

Note: By the combination of aspect ratio change and position shift, user can remove image black

border or select special region of the image to highlight (pop up) specific content in the video wall.

12.5.5 Background color setting

User can change background color in no image area. RGB color can be separately

adjusted in 0-255 brightness range to get any color that user wants.

(2§ & (%)
B B 3 D E B B @3 W ®

Mode Type Zoom Pan Overlap Position Mode Type Zoom Pan Overlap Position

D EE] g G Green Blue Reset

Position Background

255

CHANNEL 1 CHANNEL 1

12.6 Looping playback with different display modes

Mode Type Zoom Pan Overlap Position

Mode 1 Mode 2 Mode 3 Mode 4 Mode 5
Mode 6 Mode 7 Mode 8 Mode 9 Mode 10 eLoop

CHANNEL 1

»  User can create up to10 different Display Modes and looping playback under preset time
interval. This function can be used to highlight different products from the same image content
without PC system. For instance, if one photo consists of 4 products. User can display all

products in Mode #1, then pop-up product A in Mode #2, product B in Mode #3, product C in
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Mode #4 and product D in Mode #5. After set looping playback, user will see advertisement
for complete image, then highlight each product at specific LCD in sequential order.

»  Display Modes and time interval from OSD is selectable.

»  Please note that the looping display modes starts from Mode 1. If select “3”, then only Mode
1-3 can be in the loop.

»  Maximum looping playback modes is 10. If user saves two same display Mode and execute
looping playback. Then this display Mode will have double display time interval.

»  User can apply this function to shift image with small step each time in specific time interval to

prevent from LCD burn-in mark.

1) User can select the Mode # for looping

(]

playback in [Loop Range].
2) If select “3”, then only Mode #1, Mode #2

A5 ]
@ @ LTE] @ and Mode #3 can be selected for looping
Mode Type Zoom Pan Overlap Position
playback.
el oop Range Loop Time
Mode10
= @ 1) The time interval to switch among

different Display Mode can be set by
[Loop Time].

CAKT] [ . . . .

) E_(:i 2) The max looping time interval is 10

Mode Type Zoom Overlap Position

minutes (600 seconds)
LiapRanoe #5000 Tiwe 3) User can create different [Mode #] to
600sec highlight different products from the same

s input source.

12.6.1 Example for looping playback

Please check YouTube Video at: https://youtu.be/4GcOKcuX27g
Description: 4 LCD installed at different directions.

Looping Range: 5 (5 Modes), Looping Time: 1 second

YV V V V

Display Mode settings:

- Mode 1: factory default settings, 4 independent images with the same content at different
direction

- Mode 2: to put TV1 into 1/4 of the [All in One] image

- Mode 3:to put TV1 & TV2 into 2/4 of the [All in One] image

- Mode 4: to put TV1 &TV2 & TV3 into 3/4 of the [All in One] image
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Mode 5: to combine TV1, TV2, TV3 and TV4 into one complete [All in One] image

12.6.2 Procedures to create looping playback modes

\4

To set coordinates for TV1-TV4 to become one complete image.

To save the same settings into Mode 2- Mode 5 by Galign2

Select Mode 2 and click [Write] command.
Select Mode 3 and click [Write] command.
Select Mode 4 and click [Write] command.

Select Mode 5 and click [Write] command.

To modify the settings for each Mode by Galign2

Select [Mode 1] and click [Reset] to reset Mode 1 to show source image in all TV.
Modify Mode 2 to keep TV1 setting and reset all the rest to default setting

Modify Mode 3 to keep TV1 & TV2 setting and reset all the rest to default setting
Modify Mode 4 to keep TV1, TV2 and TV3 setting and reset TV4 to default setting

To set Looping playback

Set [Loop Range] = 5 (looping from Mode 1 to Mode 5)

Set [Loop Time] = 1 (for 1 second interval)

Save to Profile 1 & 5 (Profile 5 as Backup)
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13 Detailed procedures to create custom display mode

13.1 Introduction

1) User can create all kinds of display modes for regular, portrait and irregular video wall with
different size, resolution and bezel LCDs at any angle and position through input the coordinates
of two corners (Top left and Top Right) in each LCD.

2) 4 LCD as one display unit in each VW34RA and can be cascaded with multiple units without
number limitation. The display panel shall be at 16:9 aspect ratio. If non-16:9 aspect ratio LCD is
used, it can be customized by factory.

3) PIP/POP function is still available in the custom modes created by user.

13.2 Select Preset Mode from OSD

[Mode Type] is for the selection of pre-defined modes in VW34RA.

1) Please select Mode # first, then select
»‘ [0 11T
[ ] ' Preset Mode type. It will store selected
preset mode into this Mode #.

ES ’
2) Preset Mode doesn’t execute bezel

Mode Index Overlap Position

compensation. User needs to do bezel
compensation through remote controller

or Galign2 PC Tool.

CHANNEL 1

13.3 Collect coordinates from design drawing

1) User can convert project design drawings into 1920x1080 coordinates and pick up the

coordinates at Top Left and Top Right corners in each LCD, then input to VW34RA through OSD or

39



VW34

RA User Guide

Galign2 tool to get the result. The Original Point for the coordinate system is set at Top Left

corner as (0, 0).

2) Please note that the coordinate system (1920*1080) in H&V directions should have the same

scale. In below example, user measured horizontal active display area with dimensions of
382.5cm. The vertical dimension is determined by 382.5/16*9=215.2cm. Some blanking borders
will appear. Please put “Video Wall” at the center position to get more flexibility for aspect ratio

and position adjustment.

3) In above drawing, the coordinates for TV1 and TV2 are as follows:

- 116.8cm

v' TV2 coordinate for Top Left corner= (815, 635) + Top Right corner=(447, 286)
e Top Left (815,635): 1920/382.5*162.3=815, 1080/215.2*126.6=635
e Top Right (447, 266): 1920/382.5*89=447, 1080/215.2*53=266

v" TV1 coordinate for Top Left corner= (0, 586) * Top Right corner=(366, 216)

v Please pay attention to the display direction of the TV

v" User can collect the coordinates for all 7x LCD in above and input the coordinates to 2x
VW34RA according to the output connection. There is no special connection sequence is
required.

4) Please pay attention to the display direction of the TV

1920*1080 Coordinate system

- 382.5cm >
(0, 0) (Original Point) (1920, 0)
[ A [ + A
- 89—+ > ‘
- B—F > &5
)
! 1920/382.5%89<=447
Y ) ol ;L 1080/215.2*53=266
(366,216) '\ (447, 266) 5
No) N
N

TV1

TV2 /
%

XY
" (815, 635)

1920/382.5*%162.3=815
1080/215.2*%126.6=635

(0, 1080) (1920, 1080)
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13.4 Collect coordinates from video wall picture

User can also take picture of the LCD array and put this photo into a 1920x1080 coordinates
system and collect 8 points of the coordinates for 4x LCD, then input these numbers into
VW34RA. Below are the processes:

1) The photo shall be corrected without distortion. If distortion happens, user can use [RealWorld
Paint] freeware [Transformation] function to correction image distortion, resize to 1920x1080
(Canvas size), enlarge the photo to meet border in H or V direction, then collect Top Left and Top
Right coordinates.

2) Use Microsoft Picture Manager to trim the edge of the display area or directly use [Paint] software
to trim the image. Resize to 1920x1080 image resolution in JPG or PNG format.

3) To view this photo file in Microsoft “Paint” and click mouse to capture the coordinates.

4) [RealWorld Paint] or Adobe [Photoshop] can also be used for the capture of the coordinates.

5) Load these coordinates into VW34RA to get the result.

13.4.1 Example A: 6x LCD video wall with 2x VW34RA

1) User can connect any LCD to any VW34RA output
2) To open the photo under [Paint] and trim the edge to active display area. (The outlook of [Paint]

in Windows 11 is a little different from Windows 10 but the major function is the same.

Gl b < | Test2 - Paint

Home View
=1 & cut | [ H crop 7 STA \ ;ﬁﬂ NNV OOOM&AAl-| [F outine~ | —
e Copy l' £ Resize ”7 o | meree NOOOD Qf - K Fil _
o LS ok rotate - | @A Q I 1D & e OO0 s

Clipboard Image Tools Shapes
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3) Resize the image in one edge to 1080 pixel height or 1920 pixel width and maintain aspect ratio.

depends on the video wall aspect ratio. The final resolution should be under 1920x1080)

G| 1} % & = |Test2-Paint

= 4 Cut & Crop 2N 7 o/ O OO & A [ Outline —
D Copy | * £ Resize — A ,_g, NCOOD afy - £ Fil _
Paftf Selvect ~) Rotate > a9 2 Q | Bruihf:si O 4 v KOO S|fe
9" Resize and Skew 23] Shapes
Resize

By: @ Pixels

=

D Horizontal:
I:l I Vertical:

Maintain aspect ratio

() Percentage

Skew (Degrees)

S
Horizontal:

Vertical:

4) Open [File]> [Properties] and resize the image to 1920x1080 resolution

< | Test2 - Paint

4.9

View
& Crop N N/ \/\/ODD&A utlin
Copy | * £ Resize = - A g BOOOQ Q¢ - Fill
Pazte Selved “\ Rotate 4 /0 Q Blufhes {} <> f{ 73 D O C) =

Clipboard Image Tools Shapes Colors

Image Properties @

File Attributes

Last Saved: 4/19/2016 8:07 AM

Size on disk: 625.7KB

Resolution: 72 DPI

Units Colors

() Inches () Black and white
() Centimeters @ Color

@ Pixels

Widt Height:( 1080

OK ] [ Cancel ]
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5) Make sure the final resolution should be 1920*1080. Select [All], then move the image to the center

of 1920x1080 coordinates by keyboard arrow key.

B D « = [Test2-Paint

%t o Ndcor | 4 |NVOOOB A ovine- | = EH
D [ copy[| [l X3 Resize e @ NOOOD Q1 ~| KFill — D
Pafte Se!fd \ Rotate - . 4 Yl Q Bruzhes G & i}i} wlele] Size Collol ‘ Cozlor =
Clipboard Image Tools Shapes

3 1 < 10] 1920 x IOBOEX > Size: 625.7KB

6) Click Top Left and Top Right corner in each LCD to collect the coordinates for each LCD. User can

enlarge the image to get more accurate result.

G D 0 = [Test2-Paint =R
Home. | View @
= < { Crop 2T 4 INvoOooazA utline ~ | — [ Il e
O e | ZCA T S00 a0 - G| =
Pajte Selfct “\ Rotate - @ 2 Q|| Brushes 0400 Size
Clipboard Image Tools Shapes Colors

100 1920 x 1080px Size: 625.7KB 50% (=) 1) @

= M@“ﬂ G = % =Bl 1M ||
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If the video wall has more than 4 LCD, multiple units of VW34RA is required.

User can connect the signal source to all VW34RA through daisy chain connection via loop out port.
User needs to capture Top Left and Top Right coordinates in each LCD and input to corresponding
VW34RA, then it can build an entire video wall.

If the signal source is more than 4k/2k and user wants to get higher output resolution, user needs to crop
the image into several FHD sections and assign each section to corresponding VW34RA. The cropping
line for adjacent VW34RA can be at different locations. User can use Video Wall [Zoom],

[Pan] and [Overlap] function to crop, assign and align the final position among all VW34RA. All of the
operations can be done through Remote Controller and OSD. If user want to use Galign2 PC tool, user

needs to open individual Galign window for each VW34RA for video wall settings.

13.4.2 Example B: 4K/1k signal source

|
lmnga‘ic:-mcr

(0,0) (0, ) : (1920, 0) (1920, )

VW34 RA'A (0, 1080) : (1920, 1080) VW34 RA'B (1920, 1080)

(0, 1080)

User can apply 3840x1080 signal to above configuration to get higher resolution.

To split the video wall into two 1920*1080 coordinate systems. The coordinate system should cover all
the LCD connected by one VW34RA (Max. is 4x LCD).

TV4 is inside both coordinates and user can connect TV4 with either VW34RA-A or VW34RA-B output
port.

To capture the coordinates by Microsoft “Paint” or calculation from measurement dimensions for each
LCD. Then input the coordinates following the same previous procedures.

User needs to use VW34RA Video Wall menu to set [ZOOM]: H=2, V=1, [PAN]: VW34RA-A: H=1, V=1,
VW34RA-B: H=2, V=1 and use [Overlap] to adjust the image position to let two VW34RA images

combine into one. This value can be calculated through the distance apart from image center line.

13.5 How to input coordinate for each LCD

Two ways to key-in coordinates into VW34RA:

>
>

To key-in directly from IR remote controller

To key-in through Galign2 PC tool

13.5.1 Upload coordinates via remote controller
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Output port selection

POWER

PROFILE INO CHAB Store location for manual setting display

® 00 modes
[ cr1 J cr2 Jlchs I CH

Channel Selection

uen oot .@' Procedures to key-in coordinates into VW34RA:

a 1) Select manual display mode storage location—Model~Mode4
mq ° 2) Select output port—TV1~TV4 (LCD)

D 3) Click Top LH to key-in Top Left X (horizontal) & Y (vertical)
"‘"%m rdin . rcan he number on th D.
m o & C0.0dI ates. Use ca. seeteI u bec_; the OS
——— OUT ——— 4) Click Top RH to key-in Top Right coordinates.
5) Click [Shift] to do image H&V position fine-tune in each LCD.
O 006 ‘g 6) Select [Ratio] to adjust entire video wall aspect ratio if necessary
000D 7) Select [Position] to adjust entire video wall display position if
WARP
necessary
EBLEND
q @ ° ﬁ Video wall Main menu
«o @ n ml o o
TOPIH_TOR R \RATIO | PATTERN| Entire video wall position adjustment
@ D G ad
BN S Click [PTN] key to shift OSD position.

Entire video wall aspect ratio adjustment

To adjust image position at H&V without changing image size

Top Right coordinate menu

Top Left coordinate menu

1)  After collect coordinates for all LCD, user can upload the coordinates into VW34RA though
OSsD.

2) Example to store custom mode in Mode #2
From OSD menu: [Video wall]-> [Mode Index]—> [Mode 2] - Select [TV1]> Select [Top Left/
Top Right]> Arrow key to input Coordinates—> TV1 Done
To select [TV2]> Select [Top Left/Top Right]> Arrow keys to input Coordinates> TV2 Done
Next step is to execute the same procedures for TV3 & TV4.

3) Input coordinates into Mode #2 from Remote controller Hotkeys:
Select Mode #2-> select CH-1 (TV1)-> Click [TL] (Top Left)=> input Coordinates—> Click [TR]
(Top Right)=> input Coordinates-> Done
Then select CH-2 (TV2)-> follow the same process as CH-1. Then to execute the same
procedures for CH-3 & CH-4.

4) User may have difficulty to see the OSD to set Coordinates. Please click [PTN] key together
with direction keys to shift OSD position to TV1 after finishing TV1 setting.

5) User can use Galign2 PC tool to upload coordinates.
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13.5.2 Upload coordinates via Galign2 PC tool
% VNS GeoBoxAlign Tool V1.029.190702 — X
B - r‘ 192 . 168 . 0 . 100 {* UsB Close
M.lt::e design ] Firmware update ] m
Top Left Top Right Top Left Top Right Profile
x[] 1 3l|[x [ I ol||xsld o« T 23 5373
4 T [ e | R e 3 1 a7 i i
[~ shift mode B Save
V3 TV4
Top Left Top Right Top Left Top Right
xMew ] L1 D[ xMei 1 o|||[x[Fe I D x[mE T o
vEeld L1 2l vl i T 30| veed  J00| vE 0 1 3
[~ shift mode [~ Shift mode
‘Warp Ratio ‘Warp Position
alse [ 1 vl [ T 3| wls [ 1 v [
Loop Range
O M || indext € ndex3 € indexs € ndex7 € Index9 ' it
= rice
LI"D""_T'"‘E‘ 3 C Index2 " Index4 ¢ Index6 ¢ Index8 " Index 10 -
[~ Diagram [~ Real Time Save Setting Load Setting | Gebe3
1920 1080
1) Above is PC tool (Galign2) for user to load coordinates of each LCD through USB or Ethernet.
Please key-in the coordinates for [Top Left] & [Top Right] corner in each TV (LCD) then select
Index # and press [Write] to save the settings and execute the result to VW34RA. The result will
be seen in the video wall.
2) To enable [Diagram], user can see the diagram of the monitor location in Galign2 window.
3) User can enable [Real Time] mode and use [Shift Mode], [Top Left & [Top Right] menu to do
image fine-tune position. Then close [Real Time] mode and click [Write] to execute the result.
4) User can also set H&V aspect ratio and position shift through [Warp Ratio] and [Warp Position].
5) Galign2 can read back the settings on the screen and modify in PC. This is good for the
application while user can’t see the OSD menu on the screen due to irregular array.
6) User can execute looping playback function for the Modes which have minor position difference
among them. It will prevent from Burn-in Mark on the LCD.
7) User can save data in NEXIS Wall Box Profile, in PC as backup or copy to another VW34RA.

14 Important technical issues and trouble-shooting

14.1 Prevent LCD from burn-in mark

1)

interval and display modes.

User can create up to 10 display modes and execute looping playback with selectable time
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2) User can slightly shift the image position back and forth at some time interval to prevent burn-in

mark in LCD. This is important for a still image display on the LCD.

14.2 How to increase portrait display resolution

If the display is at portrait position, user can apply the same procedures as above to build the video wall.
User can also rotate the video wall at 90/270 degrees and collect the coordinates to build the system to
get higher output resolution and better video quality. After installation, user needs to apply 90/270

degrees rotated content or to apply NEXIS Wall Box 90/270 rotation function to get correct display angle.

Rotate Video Wall at Landscape direction->
Preset Mode or coordinates to build video

wall-> apply 90/270 content or rotate content

through VW34RA to show normal image—>
: : Done :

> Comparison between landscape and rotated content in portrait display

If required video wall is at portrait position as below (3x landscape LCD stacked at vertical

position), the video wall aspect ratio is around 16: (9x3)=16:27 (H:V). User has two choices:

1. User can apply the content with 720*1080 (16:27) resolution to get non-distortion image with total
video wall vertical resolution at 1080.

2. User can also apply a content with 1823x1080 (27:16) resolution and rotate the content at 90/270
degrees in PC or media player. The final resolution will be 1823x1080:1080x720=2.53x higher.

3. VWB34RA can handle both cases no matter the content has been rotated or not. However, user

will get higher resolution image if the content can be pre-rotated.
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27:16 Aspect
ratio content

14.3 How to determine source resolution for a video wall

1)  The feeling of the video image quality is related to many factors. The final display video pixel
pitch and watching distance are two major factors in video wall.

2)  If user applies FHD signal source for a 5x5 video wall with 55” LCD, the source image pixel pitch
is 1220mmx5/1920=3.1mm. If the watching distance is more than 3m, the video quality is
acceptable. Above this dimension, user needs to apply 4k/2k signal. If watching distance can be
5m, user can apply one FHD signal to a video wall up to 8x8 matrix with 55” LCD (5mm x1920
=9.6m in width).

3) If 4k/2k signal source is applied, all the devices between signal source and LCD display shall
also be able to process or deliver the signal more than 4k/2k to achieve high quality video image.

4)  Multiple VW34RA cascade can process and deliver 4k/2k image with highest video quality.

14.4 How to show full operation menu in irreqular video wall

1) In some case, user may be difficult to see the operation menu of signal source.
2)  After the complete setup, user may be difficult to see the menu or PC Desktop for operation in
irregular video wall. User has below choices to see full screen image in LCD for further operation:
»  To connect VIW34RA Loop out port with one monitor to see full screen image.
Click Remote control at empty Mode # to see full image in each LCD.
»  To use remote controller [Reset] hotkey to reset the system to default. It will reset all display
modes saved in each Mode #. The Profile settings will be kept without being deleted. Below

are the procedures:
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Press [Reset] key=> click RH or LH direction key once=> Enter. If click RH direction key, the
system will execute [Reset All]. If click LH direction key, the system will reset [Video Wall]
settings.

3) After finish necessary operation, user needs to return to required settings to get desired display

either select different Mode # or Profile Index.

15 OSD menu and functions

OSD menu can be activated through remote controller or Web Gui through network connection.
OSD window will be showed on all channels at the same time.

One IR receiver is located at front panel and one IR extender receiver connection hole is located at
back panel of VW34RA. It can be extended up to 20m through audio extender cable.

> After finished OSD operations, please save settings into Profile [Index] for long term reservation.

OUTPUT OUTPUT

Remote controller eceiver extender

v

@
>
<
S
2
Z

15.1 [Picture] color adjustment

[Picture] menu is to adjust the color for the
entire display unit (4x LCD). It can’t do
Plcture individual colour adjustment for each LCD.
‘\: O g‘wﬂ: When the input signal is in YUV domain, all the
aentnees | Cettras o il Sh;‘f’:éss items under menu are free to be accessed. If
the input signal is in RGB domain, only
[Brightness] and [Contrast] can be adjusted.
User can do separate RGB color adjustment

under [Image Properties] menu.
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15.2 [Image Setup] for VGA input

@ [Image Setup] menu can only be activated

Image Setup . . . . .
when video input is VGA input signal.

7 (2] E3

Automatic Horizontal Position Vertical Position

Automatic: It will do automatic image alignment inside the system
Manual: manual setting for signal Phase and Clock to eliminate image noise in analog input
Horizontal Position: to adjust manually the image horizontal position.

Vertical Position: to adjust manually the image vertical position.

vV V V V V

When the input is VGA signal, please connect signal first, then power on VW34RA for image
position auto alignment. After this process, unless user applies other VGA input signal,

VW34RA will not do auto alignment again to avoid image shift.

15.3 [Image Properties]

[Image properties] has six sub-menu. These functions will apply to all channels at the same time.

Input Signal Color Scaling Output Orientation PIP Setting

CHANNEL 1

[Input Signal]: to select input port
[Color]: Colour temperature selection and RGB independent adjustment

[Scaling]: to set display aspect ratio, including POP display mode

YV V VYV V

[Output]: select output resolution. Default output is 1080p @60Hz. If the input source is 50Hz,
please select 1080p @50Hz to get the best video quality.

[Orientation]: image flip and rotation setting

[PIP setting]: to do PIP/POP settings
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15.3.1 Scaling (aspect ratio selection)

= (3]

Input Signal Color Output Orientation PIP Setting

eoFull Screen Original AR

CHANNEL 1

Select type of scaled image

15.3.2  [Output] resolution setting

& @B B

Input Signal Color Scaling Orientation PIP Setting|

©1920x1080@60 1920x1080@50

CHANNEL 1

15.3.3 Image [Orientation]

&3]

Input Signal Color Scaling Output

EI?IEIIEIIEE]

Normal 270" HMirror V Mirror HV Mirror

CHANNEL 1

Change rotation angle_

1) [Full Screen]:
To fit source image for full screen display
2) [Original AR]
To display source image with the same
aspect ratio as source image
3) The setting will also affect POP main image

display with full screen or original aspect

1) Default output is 1920*1080 @60

2) If the input source is @50Hz, please select
1920*1080 @50. It will reduce the risk for
image frame tear and will get better video

quality.

»  This image orientation function will be applied to entire display units (4x LCD).

»  Major purpose:

-- To create more Display Modes based on Pre-defined Display Modes.

-- To enhance and get more flexibility in multiple VW34RA cascade applications.

-- Through image rotation, user can get higher image resolution in portrait display mode.
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Original preset

Display Mode # 03

1) Display Mode #3 is preset in VW34RA
2) When user rotate image at 90,°a new display
) mode #03A can be achieved in VW34RA
2 After 90° rotation
3) 4x VW34RA with Mode #3 with 90rotation, user

can get 4x4 video wall display. The content

Display Mode # 3A

3 should be rotated at 90 degree to get the best

video quality.

15.3.4 PIP/POP setting

& @ B =

Input Signal Color Scaling Output Orientation

M & B @ B B B

Display Size Position Ratio Source Orientation Overlap

e Disable PIP POP1 POP2

CHANNEL 1

2 PIP (Picture in Picture)
- PIP image size is from 320*180 to 1920*1200
- Flexible position across entire video wall.
- PIP image size and aspect ratio can be adjusted through Overlap function
- Main & PIP input source is swappable
- PIP image can be across entire video wall at any position
3 POP: Picture outside Picture (side by side)
- POP to fit full screen or maintain original source aspect ratio

- POP1: Two images are placed at side by side position.
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POP2: Two images are at top/bottom position

4  Limitation in PIP/POP functions:

=

HDMI
3840x2160

When implement PIP/POP function, the main signal source can’t be rotated at 90/270°
Source: only one HDMI, DP & VGA source can be displayed on PIP/POP screen.

PIP Overlap function is only available up to 4k/30 input resolution.

HDMI VGA DisplayPort
3840x216( 1920x1200 3840x2160

N=EXIS

5 PIP Size and Position

PIP image size is from 320*180 to 1920*1200
It can be further adjusted through Overlap function to about 160*90 image size.
PIP image can cover entire video wall. User can replace entire main image with PIP image on the screen.

The PIP image size can be at any location in the video wall.

6 Ratio: Aspect Ratio of the display image. (Only apply to PIP function)

Full Screen: the same aspect ratio as main image or
Original AR: the same aspect ratio as PIP input source.

POP image aspect ratio can be adjusted through [Scaling] under [Image Properties] OSD menu.

7 Source:

User can select the input source for PIP/POP image.

Only one HDMI, DP & VGA source can be displayed on PIP/POP screen.

User can swap the position in Main and PIP image from change the selection in [Input Signal Menu). If user
selects different input source as main input, then PIP/POP will be the next

User can save different settings into [Profile] under [Options] menu and recall at any time.
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Original PIP Remove black Change S,ize and
border location

| & ) ' e
Windows 8 - Windows 8
Ultimate Ultimate

Change shape and Change shape, position and
maintain all informatrion cropping area

Ultimatc

15.4 Video Wall Setting

£3

Video Wall

8B B B B U =

Mode Index Mode Type Zoom Pan Overlap Position

CHANNEL 1

The purpose for Video Wall Setting allows user to split source image, assign images for multiple units,
select Preset display Mode, create custom display modes and cascade settings for multiple VW34RA

to become one big video wall. It consists of below functions:

»  [Mode Index]: To show display modes on OSD for user to select Mode # to store settings or to recall
the settings for further editing.

[Mode Type]: To select Preset Mode from the icon.

[Zoom]: To split source image into different sections for multiple VW34RA.

[Pan]: to assign each split image to each VW34RA.

vV V VY VYV

[Overlap]: to adjust each split image position at the right location in cascade application to become a

large video wall display.
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»  [Position]: to shift complete image in each VW34RA to let image match together in multiple unit
cascade application.

»  The maximum video wall can be up to 15x15=225 units of VW34RA. If each VW34RA is connected
with 4x LCDs, then theoretically maximum number of LCD displays can be up to 60x60=3600 LCDs
from single signal source.

15.4.1 [Zoom]: Split Image for cascade application

» A case study for multiple VW34RA cascade is described in section 11.2. Please

check.
()
(=)

Position

1) VW34RA is designed with 4 LCDs as one

Display Unit

B8 @

Mode Index Mode Type

()

Horizontal Zoom
J-}

1 1 15

2) Zoom function is to split the source image

3

Overla
; for different Display Unit in multiple

EEE

Vertical Zoom

VW34RA cascade applications.

CHANNEL 1

Change the zoom settings_

»  User can set both Horizontal and Vertical Zoom value based on the array of the Display Units.

In below example, each number means one Display Units (4 LCDs) and also means one

VW34RA. Example A:
3x1 three VW34RA horizontal

o (2]

©

cascade: --Horizontal Zoom=3

Example B: --Vertical zoom=1

(2

In 3x3 nine VW34RA

(4

(5

©

cascade: --Horizontal

(7

(8

Zoom=3

--Vertical Zoom=3

15.4.2 [Pan]: Assign image for each VW34RA in cascade application
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1) [Pan]is to assign the split image location
for each Display Unit.
2) Horizontal value is calculated from LH to

RH direction and Vertical value is

Mode Index Mode Type Zoom Overlap Position

calculated from top to bottom.
@] 23] 3) User needs to set H & V [Pan] value to

Horizontal Pan Vertical Pan

‘ 3 assign the image location for each

VW34RA to build a large video wall display.

Select the zoom window by panning

(1) (2) (3) In 3x3 nine VW34RA cascade application:

o P 6 For No. © ‘Ijlcl)l;;:oR.AQ
VW34RA: '

6 @ @ Horizontal Pan =

Horizontal Pan = 3

Vertical Pan = 1 3 Vertical Pan =2

15.4.3 [Overlap]: adjust image location and cropping area

1) [Overlap] is to adjust image cropping
E3)

location for each Display Unit
(VW34RA)

g*g [E @ @ 2) User can adjust the image location in

Mode Index Mode Type Zoom Pan Position

H&V position up to +_1800 pixels.

®LeftEdge  RightEdge TopEdge  Bottom Edge Reset 3) Through [Overlap] adjustment, user can
@ st ) align each Display Unit into the right
9 faso position in the video wall cascaded with
5 CHANNEL 1 mHinla \AAIAR A
Adjust overlap setting_ Ot PTE— VvV vOSFTN/Y

Note:

a. The [Overlap] value will change the image captured area and scaling factor. In multiple VW34RA
cascade application, if the cropping area for each VIW34RA is the same size, the [Overlap] value
in each VW34RA should be the same in order to have the same scaling factor.

b. User can use [Overlap] adjustment to change aspect ratio in video wall. If multiple VW34RA is

used, each VW34RA should apply the same Overlap value to get the same aspect ratio.
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15.4.4 [Position]: Position adjustment in entire VW34RA

Mode Index Mode Type

Zoom

Left Edge Right Edge

¢ ¢ ¢ o

Top Edge

@ (Ol 4 4 @ (o)

CHANNEL 1

Overlap 2

Bottom Edge 3

[Position] is to change the image location of
each Display Unit (VW34RA) in H&V
direction without change image cropping
range.

User can adjust the image location in H&V
position up to + 1800 pixels.

Through [Position] adjustment, user can shift
display zone in each Display Unit with the
same image size (resolution).

15,5 [Options]: OSD miscellaneous functions

® 8

Information Language

O

Reset

Setting

Accessibility

Five sub-menu under [Options]:

1)
2)
3)
4)
5)

[Information]: system information
[Language]: OSD language selection
[Reset]: System reset

[Accessibility]: Time out control
[Setting]: system control setting

CHANNEL 1

15.5.1 [Information]: System Information

PN

©

Language Reset Accessibility Setting

HDMI-1
Input Mode

HDMI-1
Input Mode
Output Mode

Model Name G413

Microcode 413R1A03

M2A90702

1920x1080 60Hz

CHANNEL 1

15.5.2 [Language]: OSD Language

57

[Information] menu shows the following

information in NEXIS Wall Box:

Input mode (Main and PIP), output mode,
Model name and Firmware/MCU code

version.
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O =B o

Information Reset Accessibility Setting

© English E | L

Changes language of menu.

15.5.3 System [Reset]

Three OSD menu languages can be selected:

English, Simplified Chinese and Traditional

Chinese

Two types of Reset can be done: Reset All & reset Video Wall.

Information Language Accessibility Setting

Reset All Video Wall

Reset GeoBox to original settings.

15.5.4 [Accessibility]

Information Language Setting

L) S D

Menu time out Logo time out Standby Time Black Screen

CHANNEL 1

15.5.4.1 [Menu Time Out]
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1) [Reset All] will reset all user settings but
the settings stored in [Profile] Index will not
be erased.

2) Reset [Video Wall] will reset the settings in
Video Wall function to factory default.

3) [Reset] hotkey is available in the bottom of

remote controller.

Four sub-menu under [Accessibility]:

1) OSD [Menu Time out]

2) Splash screen [Logo Time Out]
3) No signal input [Standby time]
4) [Black Screen] setting
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&)

® 9

Information Language Setting

D 2 =

Menu time out Logo time out Standby Time Black Screen
v

off 60sec
o

CHANNEL 1

15.5.4.2 [Logo Time Out]

® © O o)

Information Language Reset Setting

D (9 2 =

Menu time out Logo time out Standby Time Black Screen
v
of f 60sec
10

CHANNEL 1

15.5.4.3 [Standby Time]—auto shutdown time

&)

@ ©® O

Information Language Reset Setting

. 5 =

Menu time out Logo time out Standby Time Black Screen
v

of f 120sec
0o

CHANNEL 1

15.5.4.4
e
®@® & O )

information Language Reset Setting
43) ) &3
Menu time out Logo time out Standby Time Black Screen

e Off On

CHANNEL 1
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OSD [Menu Time]

1) OSD menu will disappear from the
screen based on time setting.

2) The default setting is “Off” and the OSD
menu will remain in the screen until user
activates other OSD function or
input/output mode change.

1) To set the time to show Splash Logo.
2) If zero is selected, then the splash screen
will not be showed during system booting

up period. It will reduce the boot up time.

1) The default setting for [Standby Time] is
“0”. VW34RA will not shut down output
signal when no input signal.

2) If the time is set to “60”, then VW34RA
will turn off the output signal after 60
seconds when no input signal is detected.

3) Once VW34RA detects input signal, it will
wake up and output signals again.

[Black screen]—background color when no signal input

When no signal input, the default color of
the background is Black. User can change
background color to BLUE by set it to
[OFF]. Under this condition, user will see
blue background with “ Power Saving
Mode” message on the screen when no
input signal.
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Note: If user changes the aspect ratio through [Ratio] menu, it may create some no-image

background. User can change this kind of background color to any color through [Video Wall]>

[Mode Index]> [Mode #]-> [Ratio]> [Background]

15.5.5 [Setting]

15551

155.5.2

155.5.3

{2

® 9

Information Language

Mute DVIOutput BoxID Frame Sync

Accessibility

B & &

Profile Network EDID

CHANNEL 1

Audio [Mute]

(£

@ ® O

Information Language

Mute DVIOutput BoxID Frame Sync

Accessibility
B &
Profile Network EDID

©Mute Off Mute On

CHANNEL 1

DVI Output

Information Language

& B @

Mute DVIOutput BoxID Frame Sync

Accessibility
Profile Network EDID

e Off On

[Box ID]
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Seven sub-menu under [Setting] menu:
1) [Mute] Audio mute or enable

2) [DVI Output]: Output DVI mode

3) [Frame Sync]: system synchronization
4) [Box ID]: Set control ID

5) [Profile]: Save & Load settings

6) [Network]: set RS232 and Ethernet

7) [EDID]: set input EDID

Audio Mute:

1) [Mute Off] will enable audio output.
2) [Mute On] will disable audio output.
3) [Mute] hot key in remote controller is

available

If DVI Output is set to “ON”, the output
signal will change to DVI mode. There will
be no audio output. It will increase the
compatibility with some display devices,

especially in some old monitors.
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Box ID] is identification # in each
oo )
VW34RA for Ethernet, RS232 or IR

remote control.
® ® O

information | Langusoe i echs 1) NEXIS Wall Box ID No is from 1-99
x ORI | 2) After set Box ID, user can control

Mute DVI Ou:put Box ID Frame Sync Profile Network EDID NEXIS Wa” BOX |nd|V|dUa”y Via IR
[1] 99

o Remote controller, RS232 & Ethernet
3) IR control ID # is from 1-9.

15.5.5.4 [Frame Sync]

® & O =

Information Language Reset Accessibility

x @ @ B & &

Mute DVIOutput BoxID Frame Sync Profile Network EDID

Normal oFast Disable

CHANNEL 1

1)  [Frame Sync] menu has three sub-menu:
> [Normal] (Frame Locked): when user uses multiple units of VW34RA, please set at
[Normal] to let all VW34RA output synchronize together. When user resets system or
adjust video wall settings, user may see monitor re-searching the input source.
> [Fast] (Phase lock): System default setting is [Fast]. It will eliminate signal research when
change video wall settings. It is good for single VW34RA application.
> [Disable] (Free-Run mode): Once [Disable] is selected, there will be no loss signal when
changing signal source/input timing, Reset or executing video wall settings.
> We propose user to set at [Fast] while execute single unit application. During multiple unit
application, please set back to [Normal] to prevent from frame tear or not synchronized
issues among different VW34RA.
2)  The input refresh rate should be the same as output refresh rate so that the system can
implement Frame Lock to synchronize all the outputs. If the input source is 50Hz with 60Hz
output, it is possible to see synchronization issue. Please select the output refresh rate from

[Image Properties]> [Output]> select output with 50Hz.

15.5.5.5 [Profile]l—save/load user settings
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1) [Profile] is to save and load user settings
2) User can save all the settings into Profile
and recall the settings by remote
SOUNE e Accessibity controller, RS232, USB or Ethernet.
x a H & 3) When execute system reset, Profile

Mute DVIOutput BoxID Frame Sync Profile Network EDID

Sl S settings will remain the same without

change.

Case Study: when cascade with two VW34RA, user can set below display modes and save in [Profile].

1) To show cascaded image with single content across whole video wall.
2) To show two side by side contents across whole video wall.
3) To show one PIP content in cascaded image.

4) To show two PIP contents in cascaded image.

User can save these different display modes in VW34RA and recall them by RS232, remote

controller, USB or Ethernet.

15.5.5.6 [Network]

® & O =

Information Language Reset Accessibility
x E @ —
2 D] ,
Mute DVI Output BoxID Frame Sync Profile Network EDID

®RS232 Ethernet

CHANNEL 1

15.5.5.6.1 [RS232]

1) RS232 interface is designed with DB-9 connector. User can select 11520 or 9600 baud rate by
OSD, WebGui or Galign2 PC Tool.
2) The protocol can be implemented via RS-232, USB, Ethernet or other forthcoming communication

methods.
15.5.5.6.2 [Ethernet]

1) Ethernet control: VW34RA is integrated with RJ45 connector. Please connect VW34RA with Ethernet
Router or Switch/Hub via LAN port.
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2) User can controller VW34RA through Ethernet or WiFi through PC or mobile devices. A WebGui with
virtual key icons will be showed in control devices for user to execute OSD function of VW34RA.

3) VWS34RA default IP address is 192.168.0.100 and can be changed in OSD, WebGui or Galign2 PC
tool.

4) User can connect PC with VW34RA use UTP cable directly but user needs to set PC with the same
IP segment such as 192.168.0.101.

5) User can connect multiple units of VW34RA in one Ethernet Router (WiFi Router or switch/hub)
through LAN ports. After set different Static IP address for each Box, user can use WebGui virtual
keys or Galign2 PC tool to control each VW34RA independently.

6) For system control, Default TCP server port is 1266.

7) Galign PC tool can be operated by Ethernet or USB.

1. DHCP & Static IP can be set in each
VW34RA for independent operation.

@ @ O 2. User can use < > OSD direction keys to

Information Language Reset Accessibility access to the item for the modification

x @ | 8 and A v OSD direction keys to change
Mute DVIOutput BoxID Frame Sync Profile the |P addreSS Settings.
eDHCP IP Static IP

CHANNEL 1

@ 89 O

DHCP setting menu.

Information Language Reset Accessibility

IP Address Default Gateway
0. 0 .0

O OO

Subnet Mask
Q. 05 0 e Exit Renew

CHANNEL 1

Static IP setting menu.

Information Language Accessibility

IP Address Default Gateway
182.168. 0.100 182.168. O. 1

Subnet Mask
255.255.255. O e Exit

CHANNEL 1
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15.5.5.7 [EDID] setting

Selectable EDID setting is added into VW34RA The purpose are as
falow\éw34RA can support big range of input signal timing— H=1024-3840, V= 720-2400.

2) Different PC display cards have different setting and behavier. Many users may not be able to

do the right settings

3) Different display modes may show different final image aspect ratio. User can apply different

EDID setting to change input signal timing and change image aspect ratio.

®

Information

Language

> @ @

Mute DVI Output BoxID Frame Sync

Accessibility

B & &

Profile Network EDID

CHANNEL 1

)

®@® & O =

Information Language Reset Accessibility

© 3840x2160p60 3840x2160p30 1920x1080p60 1024x768p60

1280x720p60 1280x800p60 1920x1200p60 1920x2160p60

2560x1440p60 2560x1600p60 3840x1080p60 3840x2400p60

3840x2400p30 Customize

k=)

@

Information

9

Language

® Width
1920
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1) Activate EDID OSD setting menu:
[Options] > [Setting]> [EDID]

2) Use IR remote controller, WebGui or
PC tool to select desired EDID.

3) After select EDID, the PC should
automatically change output timing.

4) Press [INFO] key to check if the input

and output timing are set correctly.

13 preset EDID that can be selected by
user. Default EDID is 3840*2160
@60Hz. User can also set hon-VESA
standard EDID timing manually. The
range will be H=1024-3840, V= 720-
2400. Based on VESA standard,
Horizontal resolution is in a step of 8

pixels and vertical resolution is 1 pixel.

Accessibility

Apply

CHANNEL 1
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1) Some PC may not follow the EDID settings from VW34RA due to driver or setting issue and show
different result. If it happens, please open PC resolution setting window and select desired output
resolution from PC. User may also need to reboot PC again to get the right output resolution.

2) If user wants to create custom output resolution in PC, user needs to select NEXIS Wall Box as display
device for further settings. Please select Reduced Blanking timing in high resolution output to reduce the
output clock for easy high-speed data connection.

3) After user creates custom output resolution in PC, use needs to go back to Resolution Selection
Window (Display panel) in PC to select the desired output timing.

4) Each input port can have different EDID timing setting.

Note: Some devices (media player) may only detect EDID information during booting stage and not

output the right timing for VW34RA. Please open NEXIS Wall Box 3-5 seconds before open signal source

so that signal source can detect the EDID setting in NEXIS Wall Box and sends out the right timing.

16 Trouble Shooting

16.1

16.2

Front Panel LED lights

1) User should see Input / Output LED lights in each channel. If no LED light in specific channel,
please check Input / Output connecting cables, signal source & monitor in that channel.

2) If user sees continuous flashing in [Power] LED with 0.5 second interval, it means OSD menu is
locked. Please press [Menu] key in remote controller for 5 seconds, it will disable [OSD locked]
function.

3) If[Power] LED is flashing with 1 second interval, the system is locked through Box ID function.

Please use remote controller and press [850] number keys to disable OSD Menu Lock.

Intermittent or Loss of Input Signal

1) Check the HDMI cable quality and make sure all cables are fitted correctly. 4k/60 signal requires
high speed certified cables.

2) Cable length: Connecting cable length should be short as possible. Replace a short cable to
verify the possible root cause.

3) HDCP compliant issues: If the input source or the monitors are not HDCP compliant, it is
possible to stop VW34RA from negotiating HDCP link and show intermittent, abnormal or no
image.

4) Resolution issues: check if signal source and connecting cables can provide right signal
requested by VW34RA.

5) DVI/HDMI signal compatibility: some display devices may only support HDMI or DVI video signal
and execute wrong signal format detecting. The default output is HDMI. User can change output

with DVI format through [Options]—> [Setting]—> [DVI]-> [On].
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16.3

16.4

16.5

16.6

6)

7)

Usually, to swap with different cable, output channel, signal source and monitor can verify the
root cause for the failure.
When it is possible to have signal compatibility issue, user can add one HDMI splitter or switch

in the middle to change signal impedance. It may fix the issue.

Image rotation can’t be implemented in PIP/POP mode

Image 90/270 degree rotation function will be disabled when PIP/POP is functional.

Video quality issues

1)

2)

6)

Use the highest resolution and number of color bits (RGB 4:4:4) images allowed by VW34RA to
be used as a signal source whenever possible.

If multiple units of VW34RA is used, please apply 4k signal source and apply Preset Mode to
configure complete video wall. User needs to use [Video Wall] to split signal source for each
VW34RA to get higher resolution.

There are a number of lower-quality AV players, the specification and actual output are
difference, or because of the use of lower color sampling bits or poor image compression
technology, resulting in lower quality or image is not smooth (LAG).

If use H.264/H.265 compressed files, please select a player with hardware decoding to get
smooth video quality.

If the input signal is interlaced signal (interlaced-1080i), and the image is rotated or flipped, then
the channel will have no [3D Motion adaptive de-interlaced] processing function. If user applies
static image source, the output video will have a slight jitter phenomenon. The processing
channel quality will be reduced. Use a progressive signal source setting (1080p/2160p)
whenever possible.

Please press [INFO] shortcut key to check the input/output signal settings.

System setting can’t be executed

1)

2)

3)

Please Power ON/OFF system again or reset system through remote controller [Options]>
[Reset]> [Reset All].

After FW update, please insert small pin into RESET hole on back panel for 5 seconds to reset
the system to default to eliminate unnecessary settings. It will not affect Profile Index data.

After Reset, user will see “Reset to Default” message and the FW update process is finished.

Synchronization issue in the outputs

1)

2)

The input refresh rate should be the same as output refresh rate so that the system can
implement Frame Lock to synchronize all the outputs. If the input source is 50Hz with 60Hz
output, then it is possible to see some lag among the displays.

The display devices may have different delay time under different settings. For examples, if the
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system with high end video processing, such as noise reduction or ME/MC, it may increase few

frame delays. Please make sure all the display with the same settings.

17 Technical support

1)
2)

3)
4)

User can send e-mail to together with as much information as possible.
The following information is required for a swift response.

Sink device (monitor): type and model number

Monitor layout or specific application details (shape of video wall).

NEXIS Wall Box model No. and series No. (on the back of the box)

Detailed timing of signal source and resolution.

YV V V V

Press [Info] key to get System Information and send the data/photo to us, including
input/output timing and F/W version.

»  The exact nature of the problem. Please be as detailed as possible.

» If possible, please attach the Pictures of the issue.

Usually we will response with 24 hours (excluding weekends)

If the machine is sent back for repair under RMA, user needs to pay for return delivery cost.

18 Safety precaution and maintenance

1)

2)

3)

4)

Power Supply

Please connect electric power for all devices in the system from the same Power Distribution
Box with correct grounding. Open the power after finishing system connection to reduce the risk
for system damage from high floating voltage.

Working Environment

Please locate VW34RA in an environment free from dust, moisture and high temperature with
good ventilation.

Warranty:

This device is designed and tested to the highest standards and backed by two years’ parts and
labor warranty. Warranties are effective upon the first delivery date to the end customer and are
non-transferable. Warranty period extension is available up to 5 years through paying extra

charges.

Maintenance and Repair

Apart from what is detailed in User Guide, maintenance should be carried out by competent
technician assigned by NEXIS. If VW34RA is physically damaged, it should be returned for
repair using NEXIS RMA procedures. If the unit is opened by user, it will lose the right for

warranty protection.
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Specifications

Main items Functions Description
4 screen LCD video wall controller with preset
General
display modes and allow user to create all kinds
description

of irregular video wall

Main function

Video processor

10-bits

LCD to be controlled via one processing box

4

Multiple unit cascade

Yes (more than 10 boxes)

Video wall with portrait display

Yes, no need to rotate source image

Video wall with PIP/POP

Yes

Support 4k/2k @60hz input without compression

Yes (up to 7680*1200 @30Hz)

Preset modes selected by OSD

Yes (25 preset modes)

Input & Output

Video Input Ports

1x DP 1.2, 2x HDMI 2.0b, 1x VGA

Video Output ports

4x HDMI 1.4

Output resolution to each LCD

1920*1080P

Loop out port for daisy chain connection

HDMI 4k/2k @60Hz or 7680*1200 @30Hz

Audio Output

HDMI embedded audio

System synchronization

Frame Lock

HDCP compliant for HDMI / DisplayPort

HDMI: HDCP V2.2/1.4, DP: HDCP V1.4

Image rotation

Image 90/180/270 flip and rotation up to 4k/60

Yes (Entire video wall image)

Latency

System latency

20ms

Preset Mode

25 preset modes

Selected from OSD through remote controller or

Ethernet

Preset modes are editable to meet different bezel

size and installation condition requirements.

Advanced Video

Wall setting

Display Unit (group) and cascade

One VW34RA can control 4x LCD (as one [Display

Unit]). Multiple display units can be cascaded.

Maximum signal resolution cropped for video wall when

apply 4k/2k source signal.

- Video wall with one VW34RA (4x LCD):

VW34RA will shrink 4k/2k image to FHD,

then split into different sections and scale

up to FHD for each LCD.
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- Video wall with 4x VW34RA (16x LCD):
Each VW34RA can crop one full HD image
from 4k/2k and achieve high quality

4k/2k/60Hz video wall.

+_ 1800 pixels in horizontal and vertical directions
Position shift in entire [Display Unit]
for multiple [Display Unit] cascade alignment

Irregular display modes created by user Through remote controller or Galign PC tool

Overall video wall image aspect ratio adjustment 25% to 200% in H&V with 1% interval continuously

The range is subject to aspect ratio adjustment.
Overall video wall image position shift
Maximum is from 25% to 200%

Looping Up to 10 display modes with selectable time
Seamless looping playback for different display modes
playback interval from 1 second to 600 seconds.

Image shift for
Image position shift to prevent LCD from burn-in mark Using playback function to achieve it
LCD protection

- PIP image size is from 320*180 to 1920*1200
- Flexible position across entire video wall.

PIP (picture in picture on entire video wall) - PIP image size and aspect ratio can be
adjusted through Overlap function

- Main & PIP input source is swappable

PIP (picture in - Full screen or keep original signal aspect ratio.
POP (show side by side image on entire video wall)

picture) and - Two images can be side by side or top/down

POP (Side by [High end 3D motion adaptive de-interlace in PIP/POP Yes

Side) - When implement PIP/POP function, the main
signal source can’t be rotated at 90/270°

- Source: only one HDMI, DP & VGA source can

Limitation in PIP/POP function
be displayed on PIP/POP screen.

- PIP Overlap function is only available up to

4k/30 input resolution.

10 bits high end video processor with 4:4:4 full 3D motion adaptive de-interlace, smooth edge
bandwidth uncompressed color sampling algorithm and 3:2/2:2 film mode processing
Video
High quality video and graphics scaling up/down Yes
processing

Color adjustment (Hue, saturation, sharpness, contrast,
Applied to 4 LCD at the same time
brightness, preset modes, discrete RGB adjustment)

Full function IR Remote controller Yes

69




VW34RA User Guide

System control

for easy use

Cabled IR Receiver Extender

Can be extended up to 20m via audio cable

Ethernet control and operation via LAN or WiFi Yes
Setup and control through USB Yes
ASCII control protocol over RS-232 & Ethernet Yes
[GAlign] PC tool for easy image alignment Yes
Auto Shut off output signal when input is missing Yes
Selectable EDID resolution for optimized video quality Yes
Ear mount Option

Power supply

Dual power supply system, when use AC power supply,

DC jack can provide DC12V 1A output power

AC: 100-240V/0.25A or DC 12V/2A

Power consumption: 13.2W

Dimension

Only Box body, not including remote controller, power

supply and packing

Dimensions (Body only):
440mm*181mm*44mm (without protruding
parts). 440mm*192mm*55mm (including
protruding part)

Weight

Without accessories

2.29kg
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